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Design & Visual 
Communications 1.3
The following provides a record of the daily studio process.  
A typical studio meeting includes review of work in progress, 
introduction of new concepts, skill building, sketching and computer 
instruction.

Class 1: Monday

Welcome & Take Roll
Hope you had a good although short break.

Syllabus Review
Materials & Texts 
New Text:  Book on architect. 
Bring to class:  In-class materials, Syllabus 
 Reading Assignments, Book on Architect.
In-class Sketching:  Have news print pad by Friday.

Info Sheet
Pass around the information sheet to edit or fill in.

Sketchbook
Start a new sketchbook:  9 x 12 
Always have sketchbook in class.

Syllabus
Review Base Syllabus and 133 Syllabus 
Bring questions to the next class.

Setting Personal Goals
Write your name at the top of a piece of typing paper. 
Set three goals for yourself relative to this class. 
Be specific.  What tangible evidence will be used as indicators that you have met 
each goal? 
Time:  15 minutes
Divide into small groups and introduce yourselves.   
Share your personal goals. 
Feedback:  Would you be able see if the person met their goals?
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Break:  15 min.

Computer Tutorial:  Photoshop
Hand out CDs to copy files to computers.
Required Tools and Techniques
Type:  77-78 (343 - 368) 
Point versus Paragraph Type Blocks 
Options Bar & Character & Paragraph palettes (Layer > Type > Convert to) 
Transform & Free Transform operations. 
Select layer and choose Layer > Rasterize > Type
Clipping Groups/Masks:  61 (283 - 284) 
Option-click/Alt-click between layers (base layer name will be underlined)
Layer Effects/Styles:  48 (291 - 306) 
Choose an effect from the Add Layer Style pop-up menu (f) 
Drag effect name to Delete Layer Button (Trash) to remove 
Drag "Effects" to Delete Layer Button (Trash) to remove all 
Option-click/Alt-click to Reset Layer Style dialog box 
Select all and Crop to eliminate pixels beyond limits of the page.
Name Card
Defining page size and resolution.  5"h x 8"w x 150 spi 
Bring in image. 
Type name. 
Make clipping group. 
Define and assign Layer Style. 
Select all and crop.

Name Cards & Covers
Show examples of past name cards. 
Show examples of past covers. 
Read CD Cover and Photoshop Name Card requirements. 
Covers must follow same digital requirements as cards 
Answer questions 
Due Friday:  Card & Cover  
Prints and files on CD 
wbenedic_Card 
wbenedic_Cover
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Expressive Bibliography:  Composite Drawing
Sketch things from the book that capture some of the essential qualities of the 
architect’s work.  Complete a minimum of five quick sketches.  Lead the process 
of selecting and drawing in five minute blocks.  Work in your sketchbook. 
Time:  30 min..
Expressive Composite Drawing
Create a composite drawing of impressions of your architect’s work. 
Show past examples: 
Typing paper.  Media Open. 
Minimum of four drawings. 
Minimum of two adjectives. 
Architect's name.
Due Friday: 
Composite Drawing.
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Class 2:  WEDNESDAY

Holiday

Name Cards & Covers
Hang all cards on the wall. 
One goal was to make your first name prominent. 
Which ones do and don’t and why?
Make comments on designs.
Due Friday:  Card & Cover  
Prints and files on CD 
wbenedic_Card 
wbenedic_Cover

Computer Tutorial:  Photoshop
Respond to Questions
Layer Masks
Layer Masks:  49-50 (278 - 282)
Gradient tool for crating masks.
Paint brush for creating masks.
Selections for creating masks.
Select and feather for creating masks.
Selections:  39-44 (123 - 138)
Layers:  45-48 (105 - 122) (269 - 274)
Rulers & Guides:  (149 - 151)
Defining, Showing, Snapping:  23
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CLASS 3:  FRIDAY

Syllabus
Any questions?

Big Friday Drawings
Do a series of continuous line scribble drawings to loosen up for the quarter.  
Time:  4 minutes.

Name Cards & Covers
Show all cards & covers under the camera. 
Hang all cards on the wall. 
One goal was to make your first name prominent. 
Which ones do and don’t and why?
Collect cards and CDs.

Break:  15 min.

Expressive Bibliography
Show past work and introduce the problem.
Read the project statement.
Examples of past work have been hung on the wall.  They include resubmittals 
and those that I have changed.
Analyze the examples to see what changes have been made.  What changes do 
you think improved the designs?  Why?  What is the design principle that the 
change is responding to?  What can be learned from the examples?
Each person must contribute one observation.  Who would like to start?
Add comments and observations.
Reflection
Hand out paper: 
Each person is to describe (words and diagrams) three things that were learned or 
reinforced about design from the examples and discussion.
Collect the papers..
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Expressive Bibliography:  Research
Research and develop your bibliography. 
Refer to the handout.
Due Monday: 
Bibliographic references to hand in.

Expressive Bibliography:  Drawing Images
Each of you must provide three scanned images form your architect to be used 
for in-class drawing.  Refer to problem statement.
Due Monday: 
Files on CD.

Break:  15 min.

Expressive Bibliography
Hang composite drawings on the wall. 
What do they indicate as potential sources of things from architect’s work? 
Material, color, shapes, details, open/closed, ????
What do the drawings suggest as approaches to the solution of this project.
Layout Alternatives
Show examples of layout thumbnails.  Discuss their essential content.  Illustrate 
the goal and graphic quality.  Remember to reflect the proportions of a legal sheet 
in your thumbnails.
Sketch presentation layout based on a plan or section of one of your architect’s 
buildings.  Time 8 minutes. 
Sketch presentation layout based on a image of your architect’s work.  Time 8 
minutes.
Sketch presentation layout based a quote on your architect’s work.  Time 8 min-
utes.
Choose some to comment on to the class.
Due Monday: 
Minimum of six layout thumbnail sketches in sketchbook. 
Two developed thumbnails on typing paper. 
Media:  Pen, colored pencil and marker.
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Computer Tutorial:  Photoshop
Respond to Questions
Layer Masks
Layer Masks:  49-50 (278 - 282)
Gradient tool for crating masks.
Paint brush for creating masks.
Selections for creating masks.
Select and feather for creating masks.
Selections:  39-44 (123 - 138)
Layers:  45-48 (105 - 122) (269 - 274)
Rulers & Guides:  (149 - 151)
Defining, Showing, Snapping:  23
In-class Exercise
Defining page size and resolution.  8"h x 10"w @ 150 spi
Bring in Images.  Images you bring in should also be 150 spi. and as big or big-
ger than they will be used.  Ideal is same size as they will be used.  An image will 
change size to match the current file resolution.
Edit and blend images. 
Edit with a layer mask. 
Edit with a selection and deleting.
Transform Layer.  With a layer active choose Edit > Transform. 
Review options including numeric entry.
Defringe a layer.

Expressive Bibliography:  Collage
Create a collage of your architect’s work. 
Refer to the project statement.
Due Monday: 
Print & Digital file on CD.
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CLASS 4:  MONDAY

Drawing Feelings
Introduce the idea of drawing intangible things. 
Designers are in the business of transforming ideas into things. 
Do the first diagramming exercise as described.
Small groups:  Note any similarities and differences among drawings. 
Hang drawings on the wall.
See a pattern of responses to one of the feelings. 
Draw a diagram in your sketchbook that captures the pattern and note your inter-
pretation of the meaning of the pattern.
See two very different responses to one feeling. 
Draw a diagram of each response and note your interpretation of the meaning of 
each response.
How would you interpret some of the drawings?
Summary: 
Expression is based on our bodily experience of the world. 
Diagrams by their nature must focus on a few qualities.

Break:  15 min.

Expressive Bibliography:  Collage
Hand out paper.   
Record your name and computer questions.
Small groups to present collages. 
Say one new thing you learned about your architect. 
Answer computer questions.  Share any computer techniques or processes.
Hang collages on the wall. 
Something you tried in the collage that you might use in your final design. 
An ideas you saw in your small groups or see on the wall that you want to note. 
Collect Collage Print
Collect Files on CD (Collage and Drawing Images)
Collect Bibliographies (check off and return immediately)

Expressive Bibliography
Small groups. 
Share ideas about layout designs.
Gather and ask for questions?
Hand our half sheets of paper for everyone to do a thumbnail of their current best 
layout idea.  Format:  2" x 3.5" 
Collect in 5 minutes.
Due Wednesday:  Preliminary Design(s) 
Bring Print.  Print Fit to page on coated letter paper & trim.
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Perspective Drawing
Review of One-Point perspective. 
Do exercises 1 and 2. 
Time 30 min.

Break:  15 min.

Computer Tutorial:  Photoshop
Respond to Questions
Layer Masks
Layer Masks:  49-50 (278 - 282)
Selections:  39-44 (123 - 138) 
Make a selection and then: 
Choose Select > Transform Selection
Layers:  45-48 (105 - 122) (269 - 274)
Rulers & Guides:  (149 - 151)
Defining, Showing, Snapping:  23
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CLASS 5:  WEDNESDAY

Drawing Meanings
Do diagramming exercise two.
Small groups to examine similarities and differences. 
Hang all drawings on the wall. 
Each group is to identify some pattern and what quality it communicates.
Due Friday: 
Look up definitions for Marriage, Democracy, Youth, Past, Present, Future

Break:  15 min.

Expressive Bibliography
Hand our small pieces of paper:   
Record Computer Questions. 
Collect questions.
Small groups to present layout designs. 
Help with computer questions.
Hang preliminaries on the wall. 
If you were to put the presentations in two categories how would you describe 
the categories? 
Make notes in your sketchbook.
Share your categories.
Why would I ask you to do this?  See what is said. 
To extract concepts as opposed to only seeing specific solutions.
Presentations that create a strong mood or expression.
Presentations that communicate a clear organization,
Critique the examples.
Due Friday: 
Final preliminary. 
Print to fit on letter size paper. 
Bring your files to class.

Break:  15 min.

Perspective Drawing
Review of One-Point perspective. 
Do exercises 3 and 4 
Time 30 min.

Computer Tutorial:  Photoshop
Respond to Questions.
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CLASS 6:  FRIDAY

Big Friday
Drawing from slides.

Drawing Concepts
Do diagramming exercise three.   
Create squares on typing paper.  Carefully letter words.   
Develop some initial ideas before doing the final drawings.   
Work 30 minutes today.  Will finish at beginning of next class.

Break: 15 min.

Expressive Bibliography
Hand our half sheets of paper. 
Write your Design Statement 
Draw a Thumbnail diagram of your layout. 
Two qualities of the architect’s work that you are trying to express. 
Two means by which you are trying to evoke those qualities. 
What is the visual hierarchy in your design.
Hang all preliminaries on the wall. 
Present in groups of four. 
Qualities you are trying to communicate. 
Means employed to support the communication.
Comments in terms of what is successful and suggestions for improvement.

Break: 15 min.

Expressive Bibliography
Continue presentations in groups of four. 
Qualities you are trying to communicate. 
Means employed to support the communication.
Comments in terms of what is successful and suggestions for improvement.
Summary comments.
Due Monday: 
Final print & digital files. 
Note file format.
Bring book on architect or some visual record of the house you are going to 
analyze for the next project.

Computers
Respond to questions and provide individual help.
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CLASS 7:  MONDAY

Perspective Drawing
One-point Perspective (Off center VP). 
Do exercise 3. 
Hint:  Dimensioning Edges That Vanish (Page 42) 
Review concepts. 
Collect Drawings. 
Time 30 min.

Drawing Concepts
Complete diagramming exercise three.  Work 15 minutes in class.
Small groups to share your drawings. 
Have someone else interpret one of your drawings and see how close they come 
to your intentions.
Hang drawings on the wall. 
What patterns do your see?   
Are there as many as in previous exercises?  Reasons?
Choose ones that are most different and have someone interpret. 
Not yours or someone in your small group. 
Can you make an alternative interpretation?
Observations and comments.
Tape into your Sketchbook.

Weekly Drawing
Drawing #1:   Looking Through.  Show examples.
Do a gesture sketch in your sketchbook from an image of your house that focuses 
on layered spaces.
Due Wednesday: 
Weekly Drawing 1.

Break:  15 min.

Expressive Bibliography
Record in your sketchbook  
2 most helpful things your learned about Photoshop. 
2 things you learned about your architect; 
2 things you learned about creating expressive designs.
Hang on wall. 
Best improvement since Friday? 
Share some of the things you learned.
Collect Papers, Prints and digital files. 
Photocopy of sketchbook reflection page.
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Break:  15 min.

Image Analysis
Introduce problem.
Due Wednesday 
Read problem statement. 
Documentation on the house you are going to analyze.

Introducing Means
Task:  Graphically communicate in as many conceptually different ways that 
there are seven things composed of three things of one kind and four of another.
Work individually in your sketchbook for four minutes.
Small groups to combine ideas and define as many concepts as possible.
Gather and have each group identify one. 
Diagram concepts on the wall as they are developed.
Due Wednesday: 
Read the What chapter of Means to Ends. 
Highlight & bring to class.
Work Time
Research your house.
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CLASS 8:  WEDNESDAY

Perspective Drawing
One-point Perspective (Off center VP). 
Do exercise 4. 
Collect Drawings. 
Time 30 min.

Weekly Drawings
Small groups to review. 
Hang on wall. 
Observations and discussions
Collect Drawings & Alternatives.

Break:  15 min.

Drawing Formal Concepts
The current project will require that you identify and diagram formal concepts 
evident in a building.  The reading in Means To Ends (What?) identifies basic 
formal concepts/means.
Diagramming exercise four asks you to diagram a series of basic design terms/
concepts.  They are to be communicated through a graphic language.  What 
makes a graphic language?  What is the graphic language used in the reading?
Introduce diagramming exercise four. 
Develop ideas in sketchbook. 
Time 20 min.
Due Friday:  Completed Diagrams 
Read "Good Graphic Communication" in Drawing Form (Pages 63-68) 
Read the "What" chapter of Means To Ends.

Break:  15 min.

Image Analysis:  Clarifying Image Continua
Questions about project?
Show past image continua presentations. 
Review requirements and goals. 
Choose one continua and do exercise.
Small groups to present Image Continua Preliminary. 
Does each person have all elements? 
Are diagrams and words clear, parallel and specific. 
Suggestions for improvement.
Hang on wall. 
Make comments.
Due Friday:  Clarifying Image Continua
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CLASS 9:  FRIDAY

Big Friday
Do three drawings at 8 minutes each.

Weekly Drawing
Hand back and make comments.
Time 20 min.

Break:  15 min.

Drawing Formal Concepts
Small groups to compare graphic languages. 
Note something using a graphic languages made clearer. 
Hang on the wall and present observations.

Readings:  What? & Good Graphic Communications
What did you note.
Highlight key issues.
Things are what we perceive. 
Meaning is our response to things perceived. 
Attributes are the observable qualities upon which meaning 
Means are the tools the designer has to create things. 
Goals are the meanings the designer intends to elicit.

Break:  15 min.

Image Analysis:  Clarifying Image Continua
Small groups to Image Continua. 
Comment on clarity, being specific and being parallel.
Hang on the wall. 
Observations?  Questions?
Collect Drawings

Image Analysis:  Cell Design
Review project requirements and cell contents. 
Show past examples.
Work on one cell in class. 
Work on typing paper. 
Review in small groups. 
Hang on wall and comment.
Due Monday: 
One Cell done in Freehand.  Bring Print & File.
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CLASS 10:  MONDAY

Perspective Drawing
68/22 method.
Show examples 
Take students through sketch approach. 
Take students through exercise 1 
Do exercises 2
Collect Exercise 2

Weekly Drawing
Drawing #2:   Light Entering.  Show examples.   
Reference Doyle:  pages 7, 8, 280.
Due Wednesday: 
Weekly Drawing 2

Break:  15 min.

Expressive Bibliography
Return project and make comments.

Break:  15 min.

Image Analysis:  Cell Design
Small groups to present cells.  Are they clear? 
Are there any questions. 
Hang on the wall. 
Best visual hierarchy in support of information? 
Comments and observations.
Work in class on an improved cell.
Collect First hand cell, digital cell and improved cell.
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CLASS 11:  WEDNESDAY

Perspective Drawing:  68/22
Do exercises 3 & 4
Collect Exercise 4

Break:  15 min.

Weekly Drawing
Small groups to present preliminaries. 
Hang all drawings on the wall. 
Share observations and discuss.
Collect drawings.

Image Analysis:  Cell Design
Make comments on first cell designs. 
Be Specific.  Be parallel.  Give examples. 
Return Phase I projects and grades.

Break:  15 min.

Image Analysis:  Cell Design
Work in class on developing ideas for cell information. 
Circulate and answer questions. 
Take breaks as needed. 
Time:  45 min.
Present idea of developing one cell. 
Show examples.
Due Friday: 
Six cells developed in sketchbook. 
Three cell designs developed in Freehand (see problem statements).
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CLASS 12:  FRIDAY

Big Friday
Get out your newspaper pad and media.
Project a drawing. 
Copy the drawing. 
Time:  8 min 
Hang on the wall & make observations.

Weekly Drawings
Return drawing #3 and make comments.

Break:  15 min.

Perspective Drawing:  68/22
Do exercises 5
Collect Exercise 5

Image Analysis:  Cell Design
Small groups to review cell designs for content. 
Choose cell with best content 
Discuss designs for hierarchy and composition. 
Choose cell with best design.
Hang chosen content and design cells on the wall. 
Hang your favorite cell design on the wall.. 
Review the chosen cells. 
What makes an successful cell? 
Discuss.
Collect and review chosen cells.
Discuss graphic decisions as they support cell hierarchy and information groups.  
Identify different approaches that were taken to create the hierarchies and group-
ings.
Work
Work on developing new cell content. 
I will review your cells and give some feedback.

Image Analysis:  Layout
Discuss overall layout constraints and requirements.
Thumbnail sketches for overall layout. 
Indicate structure, color, visual weight, text location and hierarchy, etc. 
Work in your sketchbook. 
One must be developed to fill a sheet of typing paper for Monday.
Due Monday: 
One Layout design in Freehand. 
Bring full size print.
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CLASS 13:  MONDAY

Perspective Drawing:  68/22
Do exercises 6 
Start process together to set overall scale. 
Finish grid individually.
Collect Exercise 6

Weekly Drawing
Introduce the next weekly drawing and show past examples.
Due Wednesday: 
Weekly Drawing #3

Break:  15 min.

Image Analysis:  Cell Design
Return cell designs.

Image Analysis:  Layout
Small groups to review layout ideas. 
Are all elements included in the layouts? 
Choose a cell design the has an appropriate and clear visual hierarchy.
Hang all layouts on the wall. 
Questions? 
Critique.
Collect and review chosen cells.
Due Wednesday:  
Content for all cells.  
Developed final cell design:  Bring print & file on CD
Due Friday:   
Final developed preliminary at full scale in Freehand.  Bring a print.

Break: 15 min.

Computer Tutorial:  Class 13
Hand out sheets of paper. 
Record your name. 
Computer questions.
Collect and review for tutorial.
Respond to Questions.
Bring computers on Wednesday.
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CLASS 14:  WEDNESDAY

Perspective Drawing:  60/30
60/30 Shortcut method refresher (Drawing 112-113). 
Review the principles and geometry.
Do 60/30 Exercise 1 together. 
How far back are you standing in the 3/8' scale version?
60/30 Exercise 2
Collect Exercise 2

Break:  15 min

Weekly Drawing
Small groups to present drawings. 
Discuss Being in space & Expression of light. 
Hang all drawings on the wall. 
Share observations and discuss.
Collect drawings.

Image Analysis: Cell Content
Small groups to read cell information.
Small groups to present and discuss presentation layout ideas.
Hang layout preliminaries on the wall. 
Discuss layouts.
Any questions?
Due Friday: 
Developed preliminary of final solution using Freehand. 
Bring print at full size.

Break: 15 min.

Computer Tutorial:  Class 14
Respond to Questions from last class and any new questions..
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CLASS 15:  FRIDAY

Big Friday
Get out your newspaper pad and media.

Weekly Drawings
Return drawings and make comments.

Break:  15 min.

Perspective Drawing:  60/30
60/30 Exercise 3
Collect Exercise 3

Image Analysis:  Content
Small Groups.  Switch layouts between groups. 
Check clarity and completeness of analysis images, statements and diagrams. 
Note comments for improvement on typing paper provided for each person. 
Note visual hierarchy: 1, 2, 3 
Time:  20 min.
Return projects and comments to authors.

Break:  15 min.

Image Analysis:  Layout
Hang prelims on the wall. 
Make notes in your sketchbook of two presentation ideas you do not think are 
very effective. 
Note two suggestions for how they can be improved?
Share your observations. 
Discuss and expand on suggestions.
Does anyone want to present their ideas for feedback? 
Present & Discuss.
Offer any additional observations.

Break:  15 min.
Computer:  Individual Help—Work Time
Field computer questions.
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CLASS 16:  MONDAY

Perspective Drawing:  60/30
60/30 Exercise 4
Collect Exercise 4

Weekly Drawings.
Introduce weekly drawing.
Due Wednesday: 
Drawing #4.

Image Analysis
Reflections: 
Time since class on Friday? 
1 new computer technique, process or skill. 
2 Things that you learned about designing presentations. 
2 Things that you learned about your architect or architecture.
Hang on wall. 
Successful changes since Friday. 
Observations? 
Have everyone identify something they learned about their architect or  
architecture.
Collect Work:  Final Print, CD. Grade Sheet
Due Wednesday:  Copy of Reflections.

In Celebration Of
Brief introduction to problem.
Due Wednesday: 
Read problem statement 
Two floor plans on letter size paper.

Computers
Bring computers.
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CLASS 17:  WEDNESDAY

Perspective Drawing:  Digital Grids
Build digital perspective grids. 
Spaces:  20 x 20 x 12h;  40 x 40 x 24h;  64 x 64 x 32h 
Grids:  4 x 4;  4 x 4;  8 x 8 
Views:  90/00;  68/22;  60/30 
Station points:  0', -20',  5',  0', -40', 5',  0', -64', 5' 
Center of Vision:  0', 0', 5' 
File Name:  Alias_Grids (wbenedic_Grids)
Due Friday: 
File on CD & Prints of 40 setups.

Weekly Drawings
Small groups to share Drawings. 
Hang on the wall. 
Any observations.
Collect Drawings.

Image Analysis
Collect reflections

Break:  15 min.

In Celebration Of:  Building Diagrams
Present, practice and evaluate each of the building diagrams 
Circulation and Activity 
Hang on the wall & make comments.
Geometry and Relationship 
Hang on the wall & make comments.
Review good diagram qualities.
Due Friday: 
Scanned and Printed Plans 
Final Circulation and Activity Diagrams 
Final Geometry and Relationship, Diagrams
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CLASS 18:  FRIDAY

Big Friday
Get your newsprint pads. 
Show photo of architecture to interpret in gesture drawing. 
Hang up and enjoy.

Weekly Drawings
Return and comment on drawings.
Collect reflections.

Break:  15 min

Perspective Drawing:  Digital Grids
Collect 
File on CD & Prints of 40 foot wide setups.

In Celebration Of:  Building Diagrams
Small groups to present diagrams 
Identify one thing you learned or observed. 
Hang best set on the wall. 
What did you learn or observe?
Review the goals of the Synthesis diagram. 
Work to create an initial synthesis diagram. 
Time 15 min.
Circulate and give credit for diagrams as people work.
Hang on the wall and discuss.
Due Monday: 
Scanned and Printed Plans 
Circulation and Activity Diagrams 
Geometry and Relationship, Diagrams 
Synthesis diagrams prints. 
Synthesis file on CD 
Make photocopies for yourself.
Small groups to read, discuss and diagram the Problem Statement. 
Make diagrams in your sketchbook.
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CLASS 19:  MONDAY

Perspective
Designing spaces 
9000 Exercise 05 & 06

Image Analysis
Return project and make observations.

Break:  15 min.

Weekly Drawings
Show past examples and discuss.
Due Wednesday:  Drawing 5 (THE END)

In Celebration Of:  Building Diagrams
Small groups to present Synthesis Diagrams. 
Share something you learned about your architect/architecture or 2D designs.
Hang diagrams on the wall. 
Identify ones that are successful 2D designs and why? 
Share other observations. 
Collect Diagramming Submittal

In Celebration Of:  Problem Understanding
Divide into small groups. 
Read the problem statement.  Discuss questions. 
Identify things that you want clarified. 
Respond to questions.
Each group is to discuss and identify the three most important problem elements 
needed to begin designing.
Gather and share observations. 
Program element relationships & sizes.

In Celebration Of:  Conceptual Alternatives
Break class into five groups.   
Each group has a question to brainstorm. 
Remember your group members.  
Have each group identify a concept and diagram on the wall.

Computers
Bring computers to class on Wednesday: Form-Z Refresher.
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CLASS 20:  WEDNESDAY

Weekly Drawing
Review weekly drawing.
Collect Weekly Drawing.

In Celebration Of:  Problem Understanding
Make a presentation on Bubble Diagrams and their place in the design process 
that we will use this quarter.
Work on developing a bubble diagram for the problem. 
Time:  20 min.
Hang them on the wall and discuss.

Break:  15 min.

In Celebration Of:  Conceptual Alternatives
Lettering and people drawing exercise. 
Discuss elements of good diagrams. 
Show examples. 
Organization/relationship of elements. 
Closed versus open 
Scale:  people, trees, etc. 
Clear graphic decisions:  No unnecessary detail.
Gather with your group last from last class.   
Identify conceptually different solutions to your question. 
Each person is to develop a diagram on a sheet of typing paper. 
Time:  20 min.
Hang alternatives on the wall.  Discuss and evaluate concepts. 
Correct incorrect ideas (e.g., vegetation stops sound)   
Add any ideas that have been missed.
Due Friday:   
Final Program Understanding

Break:  15 min.

In Celebration Of:  Alternatives
Discovering designs within your synthesis diagram.
Due Friday:   
Develop and scan one plan alternative.

Computers: Form-Z
Export Grids in Illustrator format.
Making quick columns and walls.
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CLASS 21:  FRIDAY

Big Friday
Get your newsprint pads. 
Show photo of architecture to interpret in gesture drawing. 
Hang up and enjoy.

Weekly Drawings
Return drawings and make comments.

Break:  15 min.

In Celebration Of: Program Understanding
Join your group and share your diagrams. 
Hang all drawings on the wall. 
Make observations and discuss the role of diagrams in design.
Collect Program Understanding.

In Celebration Of:  Design Alternatives
Small groups to present your design sketch. 
Hang on the wall and make comments.
Discuss designing spaces for human activity.
Work in class to develop additional designs. 
Time:  30 min.

Computers:  Sketch Designs
Open scan of design sketch in Photoshop. 
IF you do not have scan, export synthesis diagram as TIFF. 
Change color of the lines and save as RGB tiff at 150 spi.
Determine drawing scale based on spaces and/or site. 
Bring in as underlay in Form-Z 
Build buildable site layer 120 x 160 (120 North/South)
Fit grid to site:  Extend Tool + Shift > Click in window. 
Save grid as Site.
Pop up walls to test ideas.
Due Monday: 
Three plan sketch alternatives. 
Form-Z model from one of the plan sketches. 
Prints from the model. 
Bring computer. 
Bring book on your architect.
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CLASS 22:  MONDAY

In Celebration Of: Program Understanding
Return diagrams. 
Make comments.

Weekly Drawing
Collect your drawings from the wall.
Due Wednesday 
Set of weekly drawings.

In Celebration Of:  Design Alternatives
Small groups to present plans and prints from form-Z model #1. 
Feedback:  Response to problem.
Hang on the wall and make comments. 
Questions.
Examine square footage. 
Adjust problem statement.
Hand out paper. 
Record your name and any computer questions.

Break:  15 min.

In Celebration of:  Design Alternatives
Work on developing interior perspectives. 
Look at architect's work and sketch over form-Z framework.
Time:  45 minutes.
Hang on wall and make observations.
Keep to hand in with Design Alternatives set.
Due Wednesday: 
Three plan sketch alternatives. 
Form-Z model from second plan sketch. 
Prints from second model. 
Bring computer. 
Bring book on your architect.

Computer Tutorial
Respond to questions. 
How to punch holes in walls?  (Boolean operations or Insert hole) 
How to create sloped walls?  (Move a segment or ramp) 
How to create roofs?  (Snap to object or use vertical grid) 
How to cut something?  (Split with line)
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CLASS 23:  WEDNESDAY

Weekly Drawings
Spread drawings out on table. 
Circulate and enjoy.
Hang last drawing on the wall.
Reflections: 
2 things new you learned this quarter. 
2 most important values of weekly drawings. 
Any suggestions for changes.

Break:  15 min.

In Celebration Of:  Design Alternatives
Hand out paper. 
Record your name and any computer questions.
Small groups to present plans and prints from form-Z model #2. 
Feedback:  Response to problem.
Hang on the wall and make comments.
Work on developing interior perspectives. 
Look at architect's work and sketch over form-Z framework.
Time:  45 minutes.
Hang on wall and make observations.
Keep to hand in with Design Alternatives set.
Due Friday: 
Three plan sketch alternatives. 
Form-Z model from third plan sketch. 
Prints from third model. 
Bring computer. 
Bring book on your architect.

Computer Tutorial
Respond to questions. 
How to punch holes in walls?  (Boolean operations or Insert hole) Pgs. 79-84 
How to create sloped walls?  (Move a segment or ramp) 
How to create roofs?  (Snap to object or use vertical grid) 
How to cut something?  (Split with line) Pg 97 
Revolve Tool:  Page 85 
Copy & Rotate:  Pages 73-76 
Making curved roofs. 
Drawing with vertical Grid.



30B E N E D I C T
123 Daily2008

CLASS 24:  FRIDAY

Big Friday
Get your newsprint pads. 
Sketch of your gallery space. 
Sketch of your approach. 
Open sketch of design.

Weekly Drawings
Return weekly drawing project.

Break:  15 min.

In Celebration Of:  Design Alternatives
Hand out paper. 
Record your name and any computer questions.
Small groups to present plans and prints from form-Z model #3. 
Feedback:  Response to problem.
Hang on the wall and make comments.
Work on developing interior perspectives. 
Look at architect's work and sketch over form-Z framework.
Time:  45 minutes.
Hang on wall and make observations.
Keep to hand in with Design Alternatives set.
Due Monday: 
Design Alternatives Final Submittal. 
1/16" scale Plan preliminary. 
Bring computer. 
Bring book on your architect.

Computer Tutorial
Respond to questions.
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CLASS 25:  MONDAY

Past Projects
Return projects and grades.

Break:  15 min.

In Celebration Of:  Design Alternatives
Problem Test Diagram:   
Overlay plan and represent the following 
Individual activities/spaces with names; 
Differentiate servant and served activities/spaces; 
Differentiate interior and exterior activities/spaces; 
Differentiate activities/spaces available when the galleries are closed; 
Show visitor, employee and display movement and intensity;  
Include response to site conditions (e.g., views, sun, wind); and 
Calculate and note the square footage for each activity/space.
Small groups to present plans and perspective of strongest design. 
Feedback:  Response to problem.
Hang plan, diagram and perspective on the wall. 
In your sketchbook:  Identify two or three things that were valuable in the pro-
cess to date.  House Analysis, Problem Understanding, Alternatives.
Everyone share something.
Discuss value of process.
Collect Design Alternatives & Problem Test Diagram

Break:  15 min.

In Celebration Of:  Design Development
Discuss design development phase
Discuss drawing 1/6" plans
Due Wednesday: 
Significant progress on the Digital Model & 1/16" plan 
Bring eye-level perspective view of gallery from form-Z

Computers
Respond to individual computer questions.
Due Wednesday: 
Bring Computers
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CLASS 26:  Wednesday

In Celebration Of:  Design Alternatives
Return design alternatives.

In Celebration Of:  Design Development
Design Development. 
Divide class into three groups of between six and eight. 
Two Groups hang their work on the wall.
Five minutes to compose your presentation: 
Organization:  How have you organized the programmatic elements. 
Context:  How are you responding to the sun, wind, noise and views. 
Quality:  What will make your design memorable, experiential enjoyable.
Present in groups of three or four. 
Each person will have 1 to 2 minutes to present. 
Make notes as to questions, comments and/or suggestions. 
When all have presented, share comments and observations.

Break:  15 min.

In Celebration Of:  Design Development
Next group will present.

Break:  15 min.

In Celebration Of:  Design Development
Next group will present.
Review Design Development requirements.
Do diagram from your plan. 
Due Friday: 
Final Plan, Diagram & Model. 
Bring original drawing and prints.

Computers
Respond to individual computer questions.
Due Friday: 
Bring Computers



33B E N E D I C T
123 Daily2008

CLASS 27:  FRIDAY

Big Friday
Get your newsprint pads. 
Sketches of your design. 
8 minutes each.
Gallery 
Approach- Building Image 
Other
Final reflections: 
Key things you gained from the Big Friday drawings.

Break:  15 min.

In Celebration Of:  Design Development
Hang plan drawings on the wall. 
Make observations.
Concept Diagrams 
Overlay plan and make your concept diagrams. 
Hang on the wall and discuss.

Break:  15 min.

In Celebration Of:  Design Development
Review requirements for Design Development 
Show past examples and discuss.
Scheduling: 
Small groups: 
Brainstorm everything that you need to do between now and next Friday to meet 
the due date. 
What has to be completed by Monday & Wednesday to meet Friday’s deadline?
Due Wednesday: 
Design Development final. 
Print of layout at fit to page.
Break:  15 min.

Computer Tutorial
Photoshop
Individual Help & Work Time
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CLASS 28:  MONDAY

HOLIDAY
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CLASS 29:  WEDNESDAY

Class Starts at 9:00

Exit Interviews
Sign up for a time.

Computers
Hand out paper to record computer questions

Student Evaluation
Complete evaluations.

Break:  15 min.

In Celebration Of:  Design Development
Small groups to review perspectives. 
Hang on the wall and make comments.
Place design development work on your desk.   
I will check it off during break.

Break:  15 min

In Celebration Of:  Presentation
Small groups to present presentation preliminaries. 
Hang layout prints on the wall. 
Comment on all preliminaries. 
Observations and comments.
Due Friday 
Final presentation and digital files. 
Sketchbooks

Computers
Respond to questions.
Individual Help & Work Time
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CLASS 30:  FRIDAY

Class Starts at 9:00

In Celebration Of:  Presentation
Small groups to present designs. 
Building concept and key features. 
Layout concept and key features.
Final Submittal.
Collect Sketchbooks

Final Reflection
Hand out sheets of typing paper. 
No Names. 
Three valuable lessons from the year. 
Three things about the class that should be kept. 
Three things about the class that should be improved.
Small groups to share observations.
Gather together to share something about the year.
Put reflections in the box at the end of the room.

Exit Interviews
Sign up for a time.
 
Due by 5:00 pm on Monday 
Late Projects & Resubmittals


